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DISCLAIMER: The Weed Seed Wizard is a computer simulation tool that will predict the germination 
and seedbank numbers of a range of cropping weeds. The Wizard version you are using is a ‘General’ 
one, which predicts general patterns and trends under different management scenarios. The 
prediction of weed numbers will not be completely accurate for your area as weed characteristics, 
such as dormancy, vary significantly between regions and even between farms. The Wizard can be 
calibrated to better fit your situation by tweaking the weed species’ parameters. Instructions for this 
will be available at Workshops and under the Advanced User Help.

Tip before you start: Throughout the Weed Seed Wizard Model, are small 
question marks. Hover your mouse over these to get descriptions and help. 

Tip
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Welcome Screen 
When you first open the Weed Seed Wizard, the first screen you will see, will be 
the ‘Welcome’ screen. 

Press the ‘New’ tab to open a new scenario. 
Then press ‘Blank’ to open a new blank scenario. 

Scenario Setup Window
Go to the Scenario Setup Window by pressing on the tab on the top right hand 
side.

Select the start and finish dates for your scenario.
It is important to use the date that the weeds seeds entered the seedbank 
from the previous season (this is usually the previous harvest date) as your 
start date. The model uses to degree days to break the dormancy in the weed 
seeds and will use the start date as the day that dormancy release begins. 
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Select your Weed Species
Select your weed species and make estimates of seed numbers. It is 
recommended to initially select the seed numbers for most grasses at a level 
between 100-500, and wild radish from 50-100, depending on your question. 
It can then be adjusted up or down (once the scenario is simulated) until weed 
numbers in the first year seem reasonable. If you want to explore options for 
controlling a weed blow-out, then these can set higher, and if you want to 
explore options for keeping weeds low when they are already under control, 
they can be set lower.

Weed Recommended initial seedbank numbers

Annual ryegrass 200-500

Wild oats 100-200

Brome grass species 100-200

Barley grass 100-200

Silver grass 100-200

Wild radish 50-100

Fleabane 100-200

Barnyard Grass 50-100

Liverseed grass 50-100

Feathertop Rhodes 50-100

Sweet Summer grass 100-200

Paradoxa grass 200-500

Sow thistle 100-200

Bladder Ketmia 100-200

This can be done more accurately if paddock weed records are available.  
Estimating data from paddock weed records:

66 Count weeds plant numbers during the year and put them in as Plant 
Observations (see the ‘Plant Count’ icon in the Event Management 
Window). See if the observed plant numbers match the simulated plant 
numbers. If not, then adjust the seed numbers (in the Scenario Setup 
Window) and re-run the simulation.

66 Exact weed seed numbers can be obtained by sieving and counting 
seed numbers from soil cores collected from the paddock. These can be 
entered as Seed Observations (see the ‘Seed Observation’ icon in the Event 
Management Window). This is a lot of work and is really only useful for 
research purposes.

Select the soil type
The Wizard models available moisture in the soil profile from the weather to 
predict germination. 

66 Choose the soil type most suitable to your situation. You can edit the soil 
parameters under the Model dropdown menu on the top left (Model >Edit 
Soil Types).
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Select the weather file
Select the weather file pertinent to your farm or region from the weather files 
provided OR use your own weather file.  

66 Importing Weather Data - The Wizard comes with a set of weather files for 
each state using weather information from a CSV file. These are stored in a 
folder called weatherdata which can be found in your Weed Seed Wizard 
installation directory or on your Desktop in a folder called Weather Files.  
Choose the one most pertinent to your area or farm. If you cannot find 
one close to your location, contact us and we may be able to get it for you.

66 Using your own - You can also use your own farm’s weather records by 
putting them into an Excel spreadsheet and saving it as a CSV file. The 
spreadsheet should have the following columns, in this order:

–– Date (dd/mm/yyyy)

–– Rainfall (mm)

–– Maximum temperature (°C)

–– Minimum temperature (°C)

–– Evaporation (mm)

66 An easy way to set up your own weather file is to open one of the example 
weather files provided with Excel, save it with your own name, and modify 
the values and dates as required while leaving the existing column 
headings.

66 The Wizard will predict future years. You can select the weather for the 
Wizard to use for these future years by choosing an historical year that is 
most pertinent.  You may choose different historical years for more than 
one future year by pressing the Add button.
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Event Management Window
Go to the Event Management Window by pressing the tab on the top right hand 
side.
To add a management event, press one of the icons with a plus sign OR the 
Management Event Plus sign (in the upper left hand corner menu) and double 
click the event type you wish to add. 

1.	 Adding a Till Event
Open the Add Till Event (as described above), enter the date and the till type and 
press finish. If you wish to EDIT the seed movement or plant kill rate for each till 
type OR ADD a new till type, open the till type editor (Model> Edit Till Types). 
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2.	 Adding a Sow Event 
Open the Add Sow Event. Enter the date, the crop you wish to sow and the 
seeding type. Enter the seeding rate, EITHER as kg/ha OR as seeds/m2. You can 
also enter the viability of the seed if known. 
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3.	 Adding a Spray Event
There are three ways to add a spray event; add a herbicide that is already listed, 
add a new spray type for this scenario only; or add a new spray type for all 
scenarios. First open the Add Spray Event. 

66 Add a Herbicide that is already listed.

–– Enter the date and use the dropdown menu to choose a herbicide that 
is already listed. Make sure the control percentage for each weed is 
correct (in this case, 95% for both the weeds and the crops except for 
Roundup Ready canola). You can edit the parameters for each species 
directly in the boxes but this will only apply to this Spray Event at this 
date.

66 Add a new spray type for this scenario only

–– Type the name of the new herbicide (in this case New Spray Type) 
directly into the space. 

–– Choose the half-life of the herbicide efficacy over time (this is only 
applicable to residual herbicides). A figure of 20 to 30 is applicable for 
most residual herbicides under Australian soils and conditions – see 
Table overleaf.
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–– Choose the initial kill rate. This is the proportion of plants of this 
species that will be killed instantly upon application.

–– Choose the residual kill rate. This is the proportion of new seedlings 
of this species that will be killed upon germination. This is for residual 
herbicides only. For example, for trifluralin, the initial kill rate may be 
0%, and the half-life might be 20 days with a residual percentage of 
90%.

–– To use the same herbicide again in the same scenario, copy and 
paste the event using Edit> Copy and then Edit> Paste and change the 
date.

66 Add a new spray type for all scenarios

–– Go to Model> Add Herbicide. Type in the name of the new herbicide.

–– Choose the half-life of the herbicide efficacy over time (this is only 
applicable to residual herbicides) - see Table below. 

–– Choose the initial kill rate (This is the proportion of plants of this 
species that will be killed instantly upon application) and the residual 
kill rate (This is the proportion of new seedlings of this species that 
will be killed upon germination – see Table below). You can choose the 
General kill rates and allow the Wizard to automatically populate the 
boxes OR you can enter them for different species.

–– The new herbicide will now be part of the dropdown menu within 
Add Spray Event. You can permanently edit any of the herbicides 
under Model> Edit Herbicides and these changes will be available 
for all scenarios. Note: existing scenarios will use whatever herbicide 
parameters are saved in the scenario file, and will not read updated 
parameters unless the user manually “reselects” the herbicide.
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Tip: Make sure that you check the control percentage of the crop. Remember: If 
you have a 95% control listed for the crop after it has emerged, it will kill it and 
give strange results. 

Tip
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Table: List of common residual herbicides

Herbicide 
trade name 

examples

Active 
ingredient

Kill of live 
plants (%)

Field Residual 
Half-life in soil 

(days)

Major 
cause of 

degradation

Leaching 
potential

Sakura® pyroxasulfone 30 16-26 (faster with 
high OM)

Microbial Low

Dual Gold® S-metolachlor 20 12-50 (higher in 
clay)

Microbial Moderate 
to high

Boxer Gold® prosulfocarb 20 12-35 Microbial Low

Treflan® trifluralin 0 15-100 microbial, UV Very low

Stomp® pendimethalin 0 50-100 (70) Microbial, UV Very low

Logran® triasulfuron 95 10-300 (higher 
with high pH)

hydrolysis, 
microbial

Moderate

Avadex® triallate 0  14-130 Microbial Low

Simazine® simazine 20 40-60 (higher in 
high pH)

Microbial Low

Atrazine® atrazine 20 28-50 Microbial, UV Low

Metribuzin® metribuzin 20 17-28 Microbial moderate

Spinnaker® imazethapyr 85 17-31 UV high

Raptor® imazamox 85 28-59 Microbial, UV low

Arsenal® imazapyr 85 30-125 (shorter in 
sandy soils)

Microbial Moderate 

Flame® imazapic 85 120 Microbial Low

Diuron® diuron 5-50 
depending 

on rate

50-300 Microbial High

Grunt® hexazinone 5-50 
depending 

on rate

30-200 Microbial Very high

Hyvar X® bromacil 5-50 
depending 

on rate

60-250 Microbial Very high

Dicamba® dicamba 80-99 (BLs 
except for 
brassicas - 
30%); 0-5 
(grasses)

30-60 Microbial/UV Very high

Brodal® diflufenican 95 30 Microbial Low

Igran® terbutryn 70-99 
(BLs); 0-20 
(grasses)

14-28 Microbial Low

Starane® fluroxypyr 80-99 (BLs); 
0-5 (grasses)

36 Microbial/UV Moderate

Kerb® propyzamide 0-5 18-53 Microbial Moderate

Goal® oxyflurofen 5-90 
depending 

on rate 
(spike at 

lower end)

30-40 UV Very Low
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4.	 Adding a Harvest Event
Open the Add Harvest Event and enter the date and the crop to be harvested. 
The Wizard will predict the achieved yield with weeds by estimating how weed 
competition reduces the  potential yield without weeds. There are several 
options for what this potential yield is based on:

–– Average Season – the wizard will assume an average potential yield

–– Provided Potential Yield – enter a potential yield, for example the 
average district yield. This may be modified to account for yor soil type 
or the season. 

–– % Average Season – this will scale the average potential yield by a 
seasonal effect

–– Recorded yield – This is the measured achieved yield and should only 
be entered in real situations with known numbers of weeds. Unlike the 
other options, the potential yield is then calculated backwards from 
this achieved yield. Because of the way this calculation works, this 
option can result in strange estimates of potential yield, and so care 
should be taken if using this option.

Select a harvest type (in this case Default harvest, where 99% of the weed seeds 
were spread out the back of the header and dropped back into the seedbank). 
There are harvest options such as Chaff Cart and Narrow Windrow and pre-
harvest options such as Swathing and Green Manure. You will be given the 
opportunity to automatically load the parameters for your selection OR you can 
change these to suit (for example, a late harvest may increase the number of 
weed seeds dropped).

–– Weed seeds dropped (%) – change the percentage of weeds seeds 
dropped for each species

–– Plants killed (%) – usually this is 100% unless you want the plants to 
keep on growing

–– Crop seeds dropped (%) – usually 0%. The Wizard will assume they 
germinate on the next rains as volunteers if any have dropped

–– Yield reduction (%) – specify any yield reduction for this harvest
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5.	 Adding a Volunteer Pasture Year
You can add a pasture rotation in two ways within the Weed Seed Wizard; 
adding a volunteer pasture year which calculates the seed reduction for 
each weed species over a given year OR by sowing a pasture species and 
grazing throughout the year (see 6) Adding a Grazing Event). A Volunteer Pasture 
Year is added like this:

–– Open the Add Pasture Event and enter the start and finish date of the 
pasture year. It is recommended to set the start date as the break of 
the season and the finish date when the plants are setting seed.

–– Set the seed reduction by grazing (percentage of seed eaten or 
otherwise destroyed by grazing). You can set a default level and the 
Wizard will automatically load those figures for each weed species OR 
you can manually set each weed species.

–– You can also add a spray event for pasture topping if applicable. You 
need to be aware that Spray events kill the weeds and subsequently 
reduce the numbers setting seed. BUT you can also reduce the seed 
numbers by combining the effect of grazing and pasture topping in 
the Pasture Event editor.
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6.	 Adding a Grazing Event
You can add a pasture rotation in two ways within the Weed Seed Wizard; by 
sowing a pasture species and grazing throughout the year OR by adding 
a volunteer pasture year which calculates the seed reduction for each weed 
species over a given year (see 5) Adding a Volunteer Pasture Year). The first 
option is done like this:

–– Sow a pasture species such as clover or cadiz as described in 2) Adding 
a Sow Event.

–– Open the Add a Grazing Event and add the date, the percentage of the 
plants killed by that grazing event and the percentage of the seeds 
dropped at grazing. You can set a default level and the Wizard will 
automatically load those figures for each weed species OR you can 
manually set it for each weed species.

–– You will need to add a few grazing events during the year. For the first 
few grazing events, simulate the grazing by reducing the number of 
plants and having no seed drop (they will not have produced seed and 
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Tip

dropped them during the year)

–– For the final grazing event of the year, simulate the end of the season 
by having all the plants die (or killed) and a few seeds dropped 
depending on the intensity of the grazing

–– Add a pasture top by Adding a Spray Event

–– Repeat the grazing events for any further pasture years but reduce 
the seed drop to 0% for the pasture species in the final pasture year to 
avoid volunteers in later years

–– Following pasture, make sure you kill off the pasture species at 
every opportunity (in all Spray Events) or the Wizard will continue to 
simulate them as competing with the crop.

Tip: Copying an event or a series of events 
Simply highlight an event or a group of events (for example a whole year) and 
Edit> Copy then Edit> Paste. Choose the dates that you want the new event or 
group of events to have then Press OK. 
For a series of events that you use all the time, save them under Edit> Save Event 
List and insert them under Edit> Insert Event List



15

Build your own scenario

Helping manage your weeds

weed seed

7.	 Adding an Irrigation Event
You can add an Irrigation event in two ways; by wetting the soil to field capacity 
to simulate flood irrigation OR by add a specific amount of water in millimetres.
Open the Add Irrigation Event and enter the date then choose to wet the soil to 
field capacity or add a specific amount of water.

8.	 Adding a Plant Count Event 
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Tip

Note

The counts of weeds and crops made during the season here will help to 
compare the real and simulated plant numbers as well as aid with the calibration 
of the estimated seed numbers in the ‘Scenario Setup’.

–– Open the Add Plant Count Event and enter the date and the count (per 
square metre) of each weed species.

9.	 Adding Advanced Events 
Access these Events from the dropdown menu Under ‘Advanced Events’

Note: The Advanced Events in the model were included when it was being 
validated by trial data. It is likely that most users will not use these events. The 
model will run effectively without including any of these. They include the 
Incorporation event, the Seed Rain event, the Seed Observation event and Seed 
Reset event.

Incorporation Event
This option allows you to simulate an event that incorporates a significant 
proportion of seeds into the soil at a higher rate than the standard incorporation 
rate (e.g. a storm or a flooding event or a grazing (or stock trampling) event). It 
also allows you adjust the simulation if seed is not being incorporated into the 
soil fast enough for your particular location (although if this is a general problem 
you can also change the incorporation rate for your weed species by editing the 
species as explained later).
Enter the incorporation date and the incorporation percentage.

Seed Rain
This option allows you to scale the seed numbers dropped in any one season. 
Enter the date and the season scaling.

Seed Observation
Weed seed numbers can be obtained by sieving and counting seed numbers 
from soil cores collected from the paddock. 
Enter the date and seed observations.

Seed Reset
This allows the user to reset the weed seed numbers at any time during the 
scenario, not just at the beginning in Scenario setup. 
It creates new seed for newly-added species and adjusts the seed count 
of existing species while retaining the seed cohorts’ age, distribution and 
dormancy.
This is particularly important in long scenarios over several years. 
Enter the date and the seed numbers for each pertinent species.

Tip – Seed reset can be used to simulate a biosecurity issue, for example if seed is 
blown over the fence or has come into your farm via contaminated hay.
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Loading and Saving Parameter sets
There are different versions of the Weed Seed Wizard parameters that are 
calibrated for different regions. This is especially pertinent for the species 
parameters which often behave differently across Australia. For example 
fleabane may have different germination patterns in south Western Australia 
compared to Queensland. Also, when new herbicides are added and options are 
set, these are peculiar to your situation and your computer. 
Under the dropdown option ‘Model’ there are several options for saving and 
loading Wizard parameters.

Load a Parameter Set that is pertinent to your situation.
–– Download a Parameter set from the Weed Seed Wizard website that is 

closest to your region.

–– Under the drop-down option, ‘Model’, Choose ‘Load a Parameter 
set’. You may choose to load all of the parameters or just some. It is 
recommended that you at least load the species parameters for your 
area.

Save a Parameter Set
–– When new herbicides are added and options are changed (for example 

when you edit the weed species – Advanced User Help), these are peculiar 
to your situation and your computer. It is recommended to save your 
‘parameter’ set in a folder that you can retrieve at any time.

–– Under the drop-down option, ‘Model’, Choose ‘Save a Parameter set’.  
Choose a filename and a folder to put it into. The Default folder where 
your parameter set will be saved will be the last folder that you worked on.

Reset Parameters – this will reset the parameters to their default state
–– Under the drop-down option, ‘Model’, Choose ‘Reset Parameters’.  The 

model asks you to choose which parameters you would like to reset. 
By checking the box, the model will automatically save the current 
parameters first. 

Backup Parameters
–– Under the drop-down option, ‘Model’, Choose ‘Backup Parameters’.  

This is a quick way to backup all your parameters. The parameters 
will be saved as a zip file to your ‘Users’ directory with the date 
and time of the save, for example C:\Users\yourname\wsw_
backups\2013-09-16-10-35.sfd.zip

Simulate and Save Scenario
–– Press the Simulation tab then go to the Simulation Window to see the 

yields, plant and seed numbers.

–– Save the Scenario by ‘saving as’ a document with a name and folder 
location of your choice. 
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Simulation Window - go to this window to get the results

Harvest Sub-Window 
Harvest Sub-Window - The first screen to come up will be the ‘Harvest’ Sub-
Window. 

–– Under ‘Yield’, you will find a bar graph depicting the Yield with Weeds 
(in red) and the Potential Yield without Weeds (additive in blue) for 
each year simulated. You may choose to export the results (press the 
tab on the top right of the chart) as a CSV file or as a PNG image.

–– Under ‘Plants’ you will see a bar graph of the plants (weeds) that set 
seed at harvest. You can combine species or display each species 
separately.

–– Under ‘Seeds’ you will see a bar graph depicting the seeds returning 
to the seedbank at harvest. You can combine species or display each 
species separately.

–– Under this window, you can also choose to portray other scenarios 
that have been simulated next this one. That way, you can compare 
various weed management options.
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Plants Sub-Window
Plants Sub-Window  - Press the ‘Plants’ tab. The number of plants for each species 
(crop and weeds) over the period of the simulation is portrayed as a line graph. 
The peaks represent where the weed (or crop) germinated and a percentage 
was then subsequently killed by a control measure described in the paddock 
management record. 

66 You may choose to portray all of the plants, just the crop species, just the 
weeds or pick individual species.

66 You may choose to get the same information as a Table or export the 
results, in the same way as for the ‘Harvest Window’

Tip: Use this window to make sure that you are not killing any of your crops by 
mistake. Crops have a box shape; they all germinate together and keep the same 
plant numbers until harvest (see the picture below).

Tip
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Seeds Sub-Window
–– Press the ‘Seeds’ tab. The number of seeds in the seedbank of each 

species over the period of the simulation is portrayed as a line graph. 
The model puts the specified initial seed numbers (from Scenario 
Setup) as the starting point. The numbers decrease over each year 
as they either germinate or decay over time (e.g. seed numbers can 
reduce due to natural microbial decay and insect predation).  At 
harvest, the seedbank is replenished by seed produced over that 
season – so the peaks in seed numbers usually occur just after harvest. 

66 You may choose to portray all of the species or pick individual species.

66 You may choose to get the same information as a Table or export the 
results as for the ‘Harvest Window’

Soil Sub-Window
–– Press the ‘Soil’ tab to show the soil water content and soil temperature 

simulated from the soil type and weather records

Weather Results Sub-Window
–– Press the ‘Weather Results’ tab to show the rainfall, evaporation and 

temperature over the period of the simulation. This will give you an 
idea of the break of the season and when the weeds will germinate. 

Degree Days Sub-Window
–– Press the ‘Degree Days’ tab to look more closely at the degree days 

after ripening and dormancy and germinability characteristics of 
each species. This is an advanced feature that can be used when the 
after-ripening and dormancy characteristics of each weed species are 
changed to calibrate for individual farms. This option will be explained 
more fully under the Advanced Users Guide and at the Workshops, but 
is not likely to be useful for most users.
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Note

Zooming-in  
You can zoom in on any of the graphs by holding the left-click tab on the mouse 
and drawing a box (from the top-left to the right-bottom) over the section you 
want enlarged. To zoom back out, draw a box from the right-bottom to the top-
left.

Changing the axis range 
Sometimes you may want to compare two or more scenarios and the scale of 
the graphs is different. To change the Range or Y-axis scale, right click and select 
Properties. Choose Plot, Range Axis and Range and there will be a minimum and 
maximum range value. Other chart properties are also available in here.

Autoranging 
By default, the Wizard will automatically choose appropriate X- and Y-axis ranges 
for each chart when a scenario is simulated. If you want to stop this behaviour, 
uncheck the “Autorange” checkboxes at the top right of the chart tab. The Wizard 
will then preserve whatever chart range you set.

Export Data
Inputs – management events

66 When the same list of events needs to be entered multiple times (e.g. a 
whole year of events associated with growing a particular crop) you can 
save them as an event list and quickly insert them into your scenarios later.

66 To save the event list, select the events you want to save in the event list 
(holding down CTRL on your keyboard to select more than one event), 
then from the ‘edit’ menu select ‘save event list’. The Weed Seed Wizard will 
then ask you to provide a name for your event list.

66 To insert an event list into your scenario, open the ‘edit’ menu and select 
‘insert event list’. The Weed Seed Wizard will ask you to choose the event 
list you want to insert, and then it will ask you to select the date to insert 
the event list at. When you’ve finished making your selection the Weed 
Seed Wizard will insert the events into your scenario. 

Inputs – Exporting the event list
66 If you want to open your list of events in another program (e.g. Microsoft 

Word or Microsoft Excel) you can export your event list. To do this, open 
the ‘edit’ menu and select ‘export event list’.

66 Click the ‘browse’ button to select where the exported file will be saved to. 
Under the ‘format’ section, select CSV if you want to open your file in Excel 
or RTF if you want to open your file in Word. Under the ‘events’ section, 
choose which events you want to export (select ‘all events’ here if you’re 
not sure).

66 When you click the ‘save’ button a file will be saved at the location 
specified. Double-click the file to open it.

Outputs – Simulation and Results.
66 All of the Results in the Simulation Window (Harvest, Plants, Seeds, Soil, 

Weather and Degree Days) can be exported. To do this click the ‘export’ 



22

Build your own scenario

Helping manage your weeds

weed seed

button that appears on the top-right corner of the results.

66 The Wizard will ask you what format you want. Choose CSV to export your 
results to Microsoft Excel, or PNG to save your results as an image that can 
be inserted into web pages, PowerPoint presentations, Word documents, 
etc.

66 After you’ve selected your format the Wizard will ask you where you want 
to save your file.

66 When you’ve made your choice the Wizard will save your results to the 
location specified. Double click the file to open it. 

Outputs – Income calculator
66 The Weed Seed Wizard can also estimate your income and what weeds are 

costing you. This data can then be exported and opened in a spreadsheet 
programme like Microsoft Excel.

66 To estimate your income, open the ‘scenario’ menu and select ‘calculate 
income’. In the window that pops up you’ll see your harvest events, 
potential yield without weeds, yield with weeds, price or crop per tonne, 
potential income without weeds, income with weeds, and finally what the 
weeds have costed you. Edit the price per tonne for each harvest event, 
and the other fields will be updated to reflect this information. 

66 When you’re finished editing the prices, export the information by clicking 
the ‘export’ button and the Wizard will ask you where you want to save 
your file. When you’ve made your choice the Wizard will save your income 
data to the location specified. Double click the file to open it. 

ADVANCED USER
The Wizard also has a number of features for more advanced users that have not 
been explained above, such as editing or adding new types of weed species. 
In general, these are likely to be of most use for those users that have already 
mastered the basic and general features, and they may require some interaction 
with the model developers. It is highly recommended to save a backup of ‘your 
Wizard’ each time before and after making these kinds of changes.

Tip – some of the parameters have been locked to avoid accidental changes. To 
unlock and edit, check the box ‘Allow editing advanced parameters’.

Edit an existing species
The characteristics of weed species can be edited so that simulated species 
behave like the real weed ecotypes found locally or in specific regions. For 
example, the default ryegrass included in the Wizard behaves like a general 
Southern Australian ryegrass, but in reality ryegrass varies considerably between 
different locations in terms of characteristics like dormancy, germination timing, 
longevity and fecundity.
With care, users of the Wizard can adjust or ‘calibrate’ the characteristics of the 
weed species so that they better match the behaviour of the weed ecotypes 
found in your farm, locality or region. This is done by choosing ‘Edit Species’ from 
the ‘Model’ menu, selecting the species to edit, and then pressing ‘Edit’. Here 
the user can specify the default initial density for the species, and whether the 

Tip
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species is a weed, a crop and/or a perennial. There are also many characteristics 
of the species that can be edited through the different tabs, although some of 
these are difficult to explain in simple terms and may require collaboration with 
model developers.

66 Germination Tab: this tab allows the user to edit:

–– the proportion of seeds on the surface that are typically incorporated 
into the soil over a period of one year the degree days of ripening 
required to make more than 0%, 10%, 50%, and 90% of seeds lose 
dormancy and be ready to germinate (for example, a value of 600 
means 20 days at 30 degrees or 30 days at 20 degrees or 60 days at 10 
degrees…)

–– the minimum germination temperature for the species 

–– the maximum germination temperature for the species

–– the number of days below/above an average temperature to acquire 
and lose secondary dormancy – this is a fairly advanced feature that 
allows species to reacquire dormancy at certain times of year, such 
as the end of winter for example – a simpler option for adjusting 
how weeds germinate at different times of the year is the Monthly 
Germination Tab described below

–– the typical proportion of seeds that are viable

–– whether the species acquires secondary dormancy in cold weather (or 
in warm).

66 Monthly Germination Tab: this tab allows the user to edit the proportion of 
the seed bank that will germinate in the different months of the year. This 
restriction works on top of other restrictions such as lack of after-ripening, 
and is a relatively easy and clear way to control seasonal germination 
patterns when the mechanism controlling germination suppression at 
different times of the year is not clear.

66 Yield Tab: this tab allows the user to edit 

–– Maximum seed production per square metre - the competition-free 
yield of the species when growing at high densities, *

–– Plants per square metre for half the maximum seed production - the 
number of individual plants that give half this yield in the absence of 
competition (this corresponds to the competitiveness or size of the 
species, with a smaller number meaning the species is bigger and/or 
more competitive), *

–– Mass of 1000 seeds (to allow conversion between weight and number 
of seeds) 

–– Standard antagonism of the species ( this allows the  competitiveness 
of the species to be adjusted independently of its size), *

–– Late emergence penalty - the standard competitiveness penalty for 
this species when emerging later than another species. *

–– Minimum degree days required for this species to set seed.
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–– Degree days required for the species to set potential maximum seed 
production

–– Degree days required for the species to start dropping its seed

–– Degree days required for the species to stop dropping its seed and die

66 Persistence Tab: this tab allows the user to edit

–– the proportion of any initial seed bank that is assumed to have already 
aged (after-ripened)

–– the annual survival of seeds at different soil depths (versus mortality 
due to predation etc) 

66 Interaction Tab: this tab allows the user to edit antagonisms (competitive 
or growth/yield suppressing effect) or penalties for late emergence of this 
species against other particular species (see Tip under Yield Tab for more 
detail)

* Tip: The best way to adjust the competitiveness of your weed species is to 
change the ‘Plants per square metre for half the maximum seed production’ 
parameter – increasing this will make weeds less competitive and decreasing it 
will make them more competitive – more competitive weeds will have a greater 
impact on crop yield and also set more seeds. Normally this is the only yield/
competitiveness parameter that will need to be adjusted.

Changing maximum seed production is another easy way to adjust how weeds 
behave – the same density of weeds will have the same impact on crop yield but 
the number of seeds produced will be changed, and thus the weed densities in 
future seasons.  

The Standard Antagonism allows you to change the competitive impact of the 
species on other species (crops and other weeds) WITHOUT affecting its own 
seed production – higher antagonism means a higher impact on other species. 

The Late emergence penalty affects how the competitiveness of a weed is 
affected if it comes up later or earlier than other competing crop or weed plants 
– this number should always be less than one, and the smaller the number the 
greater the disadvantage of emerging late.  

Antagonism and the Late emergence penalty can also be adjusted to be 
different against different species, in the Interaction tab. This allows very fine 
control, such as when a weed species is notably less competitive than expected 
or notably more affected by late emergence in a particular crop.  



66 Acquired Dormancy Tab: this tab is used for species that have acquired 
dormancy.

–– Days to acquire dormancy is the number of days below (for a cold-
dormant species) or above (for a heat-dormant species) annual mean 
temperatures for this species to become dormant

–– Days to lose dormancy is the number of days above (for a cold-
dormant species) or below (for a heat-dormant species) annual mean 
temperatures for this species to lose dormancy

–– Acquire dormancy on cold. Check this box if the species is cold 
dormant and leave unchecked for heat-dormant species.

Add a new species
By choosing ‘Edit Species’ from the ‘Model’ menu, the user can also add a brand 
new species, or create a new species by duplicating an existing species with 
similar characteristics and then editing those characteristics that differ.


